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ЦЕЛЬ РАБОТЫ 
Целью курсового проекта является изучение принципов и приобре-

тение практических навыков логического проектирования полузаказной 
интегральной схемы с использованием базового матричного кристалла 
(БМК). Кроме того, студенты получают представление о средах схемотех-
нического и топологического проектирования. 
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1. ВВЕДЕНИЕ 
Базовым матричным кристаллом называется часть полупроводнико-

вой пластины с регулярным расположением сформированных в нём эле-
ментов соединённых и (или) несоединённых между собой, используемая 
для создания интегральных микросхем путем установления металлических 
межэлементных соединений.  

Базовые матричные кристаллы (БМК) являются универсальными 
кристаллами-заготовками, расположенными на полупроводниковой пла-
стине. Такие кристаллы называют базовыми, поскольку все фотошаблоны, 
за исключением слоев коммутации, для их изготовления являются посто-
янными и не зависят от реализуемой схемы. Простейшие элементы распо-
лагаются на кристалле в узлах прямоугольной матрицы, поэтому его назы-
вают матричным. Изготовление конкретной БИС на БМК осуществляется 
путем коммутации его элементов с помощью однослойной или многослой-
ной разводки. 

В результате проведения данной работы студенты получают опыт 
моделирования, размещения и разводки топологических элементов в пре-
делах БМК. Выполняется графическое (предпочтительно) или текстовое 
иерархическое описание заданной схемы, которое затем моделируется с 
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учётом технологической информации. После устранения ошибок и на-
стройки схемы выполняется иерархическая разводка. 

2. ЗАДАНИЕ НА КУРСОВОЙ ПРОЕКТ 
Эти и другие материалы к курсовому проекту можно взять на интер-

нет-сайте этого проекта [ http://lsamb.narod.ru/students/kurs1.html ]. 
Данную работу рекомендуется выполнять с помощью специализиро-

ванных САПР: моделирование в программах типа Spice (P-Spice, OrCAD, 
Tanner T-Spice и т. п.), разводку в топологическом редакторе (Tanner L-
Edit, IC Studio и т. п.). 

Варианты задания включают в себя различные цифровые фрагменты 
общего характера: счётчики, де-/мультиплексоры, де-/шифраторы, распре-
делительные блоки и т. п. 

От преподавателя нужно получить электрическую схему. Кроме то-
го, должны быть выданы электронная версия методических указаний, файл 
MOD с моделями активных элементов кристалла, файл GDS/TDB с топо-
логией кристалла, описание всего кристалла и его базовой ячейки (включая 
список технологических слоёв). 

Анализ схемы и подготовка рабочего файла для Spice 
Полученную электрическую схему устройства следует проанализи-

ровать, определить её структуру и принципы работы. Далее в графическом 
схемном редакторе следует сформировать электрическую схему и подклю-
чить файл с моделями активных элементов. 

Сформированная схема в обязательном порядке должна иметь ие-
рархическую структуру, где на нижнем уровне находятся стандартные ло-
гические ячейки (вентили), а блоки более высоких уровней складываются 
на основе структурной схемы. В частности, в отдельный блок может быть 
выделен повторяющийся фрагмент. 

При вводе схемы в программу следует быть очень внимательным: 
случаи некорректной работы схемы часто связаны именно с неправильным 
кодированием. 

Моделирование схемы 
Следующий этап – моделирование схемы в программе. Требуется ра-

зобраться в принципе работы и режимах работы схемы и продемонстриро-
вать её работоспособность. В большинстве случаев таблица истинности 
схемы задана, однако следует понять правило её формирования, особенно 
это касается последовательностных схем. Следует также подготовить ми-
нимальный набор входных тестовых сигналов, демонстрирующих работо-
способность схемы. 

http://lsamb.narod.ru/students/kurs1.html
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Все варианты задания предлагают для реализации иерархические 

схемы. Соответственно, и подготовленные фрагменты должны быть орга-
низованы иерархически. 

Частота исмпульсных входных сигналов должна быть достаточно 
высокой: длина импульса не должна превышать троекратного времени за-
держки переключения схемы, а фронт импульса не должен превышать по-
ловины времени задержки переключения схемы. 

Выходные графики должны проверять работу схемы во всех воз-
можных режимах (или переходы между некоторыми из них в случае де-
/шифратора или де-/мульплексора). 

Работоспособность схемы необходимо продемонстрировать препо-
давателю на компьютере. 

Разведение на кристалле 
Создание рисунка разводки для цифровой схемы в общем случае бо-

лее простая задача, чем для аналоговой, однако, тем не менее, она не явля-
ется тривиальной. Иерархическая структура электрической схемы обычно 
однозначно переводится в иерархическую структуру топологии. Соответ-
ственно, вначале создаётся рисунок разводки для элементов нижнего 
уровня, затем для более высоких уровней (стиль проектирования «снизу 
вверх», в отличие от стиля «сверху вниз», когда сначала располагаются 
блоки высших уровней, а затем в их пределы вмещаются блоки и ячейки 
низших уровней). Процесс внедрения блока более низкого уровня внутрь 
блока более высокого уровня называется включением. При этом в блок бо-
лее высокого уровня помещается не копия блока более низкого уровня, а 
ссылка на него. Это означает, что при редактировании блока более низкого 
уровня обновляются все его ссылки. 

Критическим параметром для разводки является минимальный раз-
мер, т. е. ширина и расстояние между соединительными линиями, а также 
расстояние между соединительными линиями и активными областями 
структуры кристалла. Для данного проекта минимальный размер – 5 мкм. 

В тех местах, где соединительная линия должна перейти на другой 
слой, вставляется проходная ячейка. Такая ячейка содержит инструкции 
для технологического оборудования по прожиганию отверстия в защитном 
покрытии микросхемы, чтобы непосредственно соединить объекты в двух 
различных слоях (например, 1-м и 2-м металлах). Проходная ячейка может 
быть квадратной или Г-образной формы. Правила норм проектирования к 
проходным ячейкам также применимы (в частности, минимальное рас-
стояние между ячейкой и проходящими в тех же слоях линиями, между 
ячейкой и активными областями кристалла). 
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Проходные ячейки в данном проекте необходимо использовать в сле-

дующих случаях: при связывании объектов в слоях металла и поликрем-
ния, при подключении соединительной линии к диффузионной области. 

Окончательная разводка отдельных блоков должна содержать только 
металлические линии и проходные ячейки. Не рекомендуется проводить 
разводку непосредственно на кристалле; следует создавать отдельные то-
пологические ячейки на фоне отдельно взятых фрагментов матрицы, а за-
тем результирующий рисунок из металлических линий и проходных ячеек 
«включать» в ячейку более высокого уровня в виде ссылки. 

3. ЦИФРОВОЙ РАДИАЦИОННО-СТОЙКИЙ БМК «МЕЛИССА–1» 

Описание кристалла 
Цифровой базовый матричный кристалл (БМК) «Мелисса–1» произ-

водится по КМОП технологии со структурой приборов «кремний на сап-
фире» (КНС), что обеспечивает повышенную радиационную стойкость. 

В центре кристалла находится матрица 23×100 цифровых ячеек, ка-
ждая из которых содержит 4 транзистора, – и 64 буферные ячейки на пе-
риферии. Конструкция и топология базовой ячейки показана на рис. 1. 

1

2 4 6 8 10 12

3 5 7 9 11

 

 

Рис. 1. Конструкция и топология базовой ячейки БМК 

Ячейка состоит из двух p-МОП и двух n-МОП транзисторов, причём 
транзисторы одного типа находятся в единой диффузионной области, а па-
ры транзисторов разного типа имеют общий затвор, образуя, таким обра-
зом, КМОП пары. 
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Цифровая матрица составлена из рядов ячеек, между которыми на-

ходятся каналы, используемые для разводки. 

Содержание файла с моделями транзисторов 
*********************** *********************** 
*      .START Models for MELISSA array chip   * 
*********************** *********************** 
*  SOS N-channel 
 
.MODEL NSOS1 nmos(level=3 L=4u W=33u  vto=1.5   tox=4.8e-08  uo=650.2 
+                theta=0.17     delta=.3105  nsub=1e+16 
+                vmax=1.4664e+07  lambda=.2493 ld=4.9318e-07 wd=1e-07 
+                kappa=3 eta=3.279 cbd=0.02p   cbs=0.02p   NFS=2e12) 
 
* SOS p-channel 
 
.MODEL PSOS1 pmos(level=3 L=3.5u  W=40u vto=-1.  tox=4.8e-08  uo=400. 
+                theta=0.4      delta=.3105  nsub=1e+16 
+                vmax=1.4664e+07  lambda=.2493 ld=4.9318e-07 wd=1e-07 
+                kappa=3 eta=3.279 cbd=0.03p   cbs=0.03p   NFS=0.5e12) 
 
*  SOS N-channel 
 
.MODEL NMOS nmos level=3 L=4u W=50u  vto=0.84   tox=4.8e-08  uo=368.4 
+                nsub=1e+16 theta=0.17     delta=.3105 lambda=.2493 
+                 vmax=1.4664e+07  ld=4.9318e-08 wd=1e-07 
+                cbd=0.02p   cbs=0.02p   NFS=2e12 
 
* SOS p-channel 
 
.MODEL PMOS pmos level=3 L=3.5u  W=50u vto=-1.9  tox=4.8e-08  uo=285.7 
+                nsub=1e+16 theta=0.4      delta=.3105 lambda=.2493 
+                 vmax=1.4664e+07  ld=4.9318e-08 wd=1e-07 
+                cbd=0.03p   cbs=0.03p   NFS=0.5e12 
 
*********************** *********************** 
*     .END Models for MELISSA array chip      * 
*********************** *********************** 

4. ПРЕДСТАВЛЕНИЕ ОТЧЁТА 
На титульном листе нужно указать название исследуемой схемы. 
Отчёт должен содержать следующие части: 

• электрическая схема устройства, на которой подписаны номера 
элементов; 

• описание принципов работы устройства; 
• описание БМК и его элементов (см. часть 3); 
• модель схемы для Spice + модели элементов (см. часть 2.3); 
• графики, демонстрирующие работу схемы (см. часть 2.2); 
• заполненный лист разводки (см. часть 6), на котором подписа-

ны номера использованных приборов; 
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5. КРАТКИЕ СВЕДЕНИЯ О ПРОГРАММЕ SPICE 
SPICE – программа моделирования электронных схем. В ней можно 

рассчитывать режимы схем по постоянному току, частотные, переходные и 
шумовые характеристики, анализировать влияние температуры. Исполь-
зуемые элементы схем: сопротивления, ёмкости, индуктивности, диоды, 
транзисторы различных типов, трансформаторы, независимые и управляе-
мые источники напряжения и тока. 

Различных программ типа SPICE много. Наиболее распространен-
ные: PSPICE для DOS, OrCAD, T-Spice (Tanner).  

Некоторые программы позволяют графический ввод схемы. В этом 
случае перевод графической информации в базовый текстовый формат 
производится внутренними средствами программы. 

Информация для программы SPICE задаётся в виде текстового файла 
определённого формата. Файл содержит описание схемы и тип выполняе-
мого анализа. Расширение входного файла в ОС Windows – .CIR или .SP. 
Выходная информация выводится, в простейшем случае, в два файла: пер-
вый содержит сообщения интерпретатора и значения рассчитываемых вы-
ходных переменных, имеет расширение .OUT; второй содержит данные 
для построения графиков, имеет расширение .DAT.  

Запуск программы (версия PSPICE для DOS) 
Запуск программы расчёта в комплексе PSPICE версия для DOS: 

нужно запустить файл PSPICE1.EXE. Программа запросит имя входного 
файла – ввести его, затем имя выходного файла – по умолчанию (нажатию 
клавиши ВВОД) имя сохранится таким же. После этого программа начнёт 
расчёт схемы. Если в процессе расчёта будут найдены ошибки, выдаётся 
звуковой сигнал через спикер и сообщение «Circuit has errors». В этом слу-
чае нужно обратиться к выходному файлу (*.OUT), в нём символом «-------
-------$» указано место ошибки и её описание. Все ошибки нужно испра-
вить. Если расчёт завершается успешно, выдаётся сообщение «Simulation 
completed successfully». В этом случае можно строить графики. Для запус-
ка программы построения графиков (PROBE) нужно запускать файл 
PROBE.EXE. Чтобы добавить графики, нужно выбрать пункт меню 
Add_Trace и ввести нужные выходные переменные через пробел. Чтобы 
выйти из программы PROBE, нужно выбрать пункт меню Exit. 

Запуск программы (версия OrCAD для Windows) 
Запуск программы расчета в комплексе OrCad 9.2 версия для Win-

dows: нужно запустить программу PSpice в меню Пуск > … > Orcad 9.2. 
Затем создать .cir файл со схемой или открыть заранее созданный файл и 
запустить расчёт (команда меню Simulation > Run или кнопка «Run Simula-
tion» на левой вертикальной панели инструментов). После этого программа 
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начнет расчёт схемы. Если в процессе расчёта будут найдены ошибки, то 
программа прервёт работу и автоматически откроется выходной файл 
(.out), куда будет выведен текст программы и ошибочные места указаны 
символом «--------------$». Внимание!!! Для устранения ошибок необходи-
мо вернуться в .cir файл (команда меню Window > View Circuit File или 
кнопка «View Circuit File» на левой вертикальной панели инструментов. 
После исправления всех ошибок следует перезапустить расчёт. По оконча-
нии расчёта для просмотра результатов необходимо выбрать пункт меню 
View > Show Simulation Results. Добавление в конец .cir файла перед опе-
ратором .END оператора .PROBE позволит автоматически открывать окно 
просмотра результатов. 

Для вывода графиков нужно, находясь в программе Probe, выбрать 
пункт меню Trace > Add Trace. Появится окно, в левой части которого бу-
дет находиться список всех возможных выходных переменных, из которых 
можно выбрать необходимые. Также можно ввести список выводимых 
графиков через пробел вручную в поле в нижней части окна. 

6. ПРИМЕР ПРОЕКТИРОВАНИЯ СХЕМЫ 

 
Рис. 2. Структурная схема (3-хканальный распределитель сигналов) 
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Рис. 3. Смоделированные характеристики 

 
Рис. 4. Топология схемы (на фоне фрагмента БМК) 
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